Pocket Artist Documentation
Introduction
Pocket Artist is a 24-bit color graphics editor for Windows Mobile 2003 for Pocket
PC, Pocket PC 2002, Pocket PC 2000, and Handheld PC 2000.
Graphics editing and drawing is done at the pixel level, in full 24-bit (RGB)
quality, although the visual appearance of the picture may vary depending on the
device. PDA's with 16-bit displays will convey greater image quality than those
with 8-bit displays. Most CE devices with 8-bit (256-color) displays have 16-bit
(65,536 colors) drivers available from the hardware manufacturer. Check with
your hardware manufacturer for more details.
Pocket Artist provides many features found in large graphic packages of today,
with the constraints of mobile devices in mind. Program memory requirements
depend on the dimensions of the image in question (with not much overhead).
Pocket Artist is distributed as a self-extracting and self-installing EXE. Simply
download the EXE to your desktop computer and run it to start the automatic
installation to your PDA.
We recommend users to have about 2MB free on their desktop machines and
500K free on their Windows CE devices. After installing, Pocket Artist will add a
shortcut to the Start Menu.

Installation
To install Pocket Artist, double-click the PocketArtist2.exe downloadable from
the download page. Upon installing, Pocket Artist will appear on your mobile
device's Start Programs menu. Pocket Artist is then installed on your device
and desktop and activated for a 30-day demo. If you would like to continue
using Pocket Artist past the 30-day trial period, you must purchase it from
Conduits Direct.
Uninstalling Pocket Artist on the device: tap Start Settings Remove
Programs, tap Pocket Artist and tap Remove. On the desktop, tap Start
Settings Control Panel Add Remove Programs, click Pocket Artist and click
Remove.

Interface Guide

After initializing, you will see this screen. It provides a rich feature set without
taking too much room for toolbars and menus. This allows as much space as
possible to be dedicated to drawing.
The main white area is the canvas in which you draw. Scroll bars appear as
required to the right and bottom of the canvas and allow you to pan around the

entire image.
At the bottom of the screen you will find the main toolbar. This toolbar allows you
to access the main menu and drawing tools.
Three other toolbars may be visible at any time. These are the Layer Toolbar,
Tool Options, and Color Picker. The Layer Toolbar and Tool Options are shown
here. You may show or hide these toolbars by using the View menu.

Main Toolbar

Tapping "Menu" will allow you to access the full main menu. The next two
buttons are Color and Brush Shape. The middle four buttons allow selection of a
tool. Tools are grouped into four categories, from left to right: Drawing Tools,
Image Tools, Selection Tools, and Text/Shape Tools. The last button on the
toolbar is Undo. Selecting this button immediately undoes the last action.
The Color button shows the current foreground color in the top left square, and
the background color in the bottom right. Tapping the middle of the Color button
will show or hide the Color Picker toolbar and allow selection of a color. Tapping
the top right of the button on the two arrows swaps the foreground and
background colors. Tapping the bottom left corner of the button on the black and
white rectangles resets the foreground and background colors to black and white
respectively.

The Brush Shape button shows the shape and size of the currently selected
brush. A number is shown below the brush shape, which gives the dimensions
(in pixels) of the brush. Tapping the Brush Shape button pops open a window to
select a different brush from the current brush set.
Tap-and-hold on the Brush Shape button to use a different brush set (.ABR file).
Pocket Artist will use any .ABR file created by Adobe Photoshop and placed in
the Brushes directory on the CE device. It will also use any BMP files in the same
directory as brushes in the Default Brushes set.
Four tool buttons are used to provide quick access to any tool. Each button
governs a set of related tools: Drawing Tools, Image Tools, Selection Tools, and
Text/Shape Tools. Only one of these buttons will be highlighted at a time to
indicate the current tool. Selecting this button will show a menu of related tools to
choose from. Tapping any other tool button will immediately switch to that tool.
Tap-and-hold on any tool button will quickly show the tool menu for that button.

Other Toolbars
The Layer Toolbar at the top of the screen is described fully in the Layers
chapter. The Tool Options toolbar appears above the main toolbar. This toolbar
changes appearance and functionality depending on what tool is selected. This
functionality is described in Painting.

The Color Picker toolbar allows rapid and precise selection of a foreground color.
On the left is a color spectrum. Tapping anywhere in this color spectrum will
allow selection of the corresponding color. White and black boxes on the right

side of the spectrum allow full white and black to be selected easily.
The box next to the color spectrum opens a swatch of standard colors to choose
from. This swatch is a 216-color web-safe palette from VisiBone.
Three boxes to the right display the red, blue, and green color components of the
currently selected color. The color components range from 0 to 255. Tapping on
any color component will pop open a window to allow fine adjustment of this
value. The value may be set using a slider at the bottom of this window or by
tapping any of the 256 color boxes in the window. The color boxes show the final
color that will result from the adjustment.

Menu Commands

Tapping "Menu" will load the following choices:
Main Menu Items
Image Menu

·
·
·
·

New: starts a new document. Will prompt if you want to save the current
document.
Open: opens a document. Also will prompt.
Save: saves the document. If you have saved the image previously, or if
you loaded the current image and have edited it, this command will save it
without a prompt.
Save As: saves the document. This will prompt for a file name and saving
type.

·
·
·
·
·
·

Close: closes the document. Will prompt if you want to save your
changes.
Revert: loads back in the last saved iteration of this document.
Recent Files: this menu item holds a list of your recently opened, edited,
or saved files.
Use as Desktop: this is a feature unique to Pocket Artist. By selecting this
you can save your work straight to your Windows CE desktop, where it will
appear there, optionally tiled.
Capture Screen: this prompts for a delay and then takes a snapshot of
the screen and puts it on the Pocket Artist clipboard. Paste it into the
document to see what was captured.
Exit: exists Pocket Artist.

Edit Menu

·
·
·
·
·
·
·

·

Undo: undoes the last command, whether it be a paint stroke or a
document command (such as resizing the image).
Cut: takes the current selection, moves it to the Pocket Artist clipboard
(not the CE clipboard), and erases the current selected area of the
document.
Copy: takes the current selection and copies it to the Pocket Artist
clipboard, retaining the selection and the document.
Paste: creates a new layer and copies data from the Pocket Artist
clipboard into the layer. This layer may be moved around or have opacity
and blending modes changed before merging with the document.
Clear: clears the current layer (or the current selection) by filling with the
background color or erasing layer data.
Transform: rotate or flip the current layer or selection
Fill: fill the current layer or selection with the foreground color, background
color, or a texture. An opacity other than full opaque (255) may be
selected. If a texture is selected, another window will open to prompt for
the texture file to use.
Preferences: edit User Preferences.

View Menu

·
·
·
·
·
·

Zoom In/Out/100%: visually zooms in and out on the document. Zoom
100% resets the view.
Zoom to Fit: zooms in or out to show the document as large as possible
while still fitting it into the document area.
Quick Zoom: a submenu of zoom increments from 12.5% to 1600%.
Layer Toolbar/Color Picker/Tool Options: toggle the visibility of the
corresponding toolbar. A checkmark appears next to toolbars that are
visible.
About Pocket Artist: shows the splash screen and copyright information
for Pocket Artist.
Documentation: a link to Pocket Artist documentation.

Adjust Menu - also see Photography & Level Tools

·
·
·
·
·
·
·
·
·
·

·

·

Levels...: adjusts the black, grey, and white levels of the layer/selection.
See Photography & Level Tools.
Auto Levels: automatically adjusts the levels to have a uniform intensity
across all levels and color balances
Auto Contrast: automatically adjusts the levels to have a uniform intensity
across all levels without altering color
Fill Shadows: for images that have large dark areas, it expands the dark
region to higher intensities to bring out detail. See Photography & Level
Tools.
Fix Overflash: for images that have large bright areas, it expands the
bright region to lower intensities to bring out detail
Bright/Contrast: a window will allow you to adjust the brightness and
contrast levels for the layer or selection. As these levels are modified,
changes take place in the document window immediately.
Hue/Saturation: a window will allow you to adjust the hue, saturation, and
lightness levels for the layer or selection. As these levels are modified,
changes take place in the document window immediately.
Color Curves: a window will allow you to adjust color levels of the layer or
selection. All colors may be affected or just red, green, or blue
components.
Desaturate: converts color image to greyscale
Invert: color values for the layer or selection will be inverted. This changes
black to white, red to cyan, green to magenta, and blue to yellow.

Image Size: this scales the image up or down in size. Constrain
proportions will keep the resulting aspect ratio the same as the original.
The resampling algorithm may be selected. Each option gives a different
tradeoff between quality and speed.
Canvas Size:

this function changes the size of the canvas without scaling the image.
The Anchor area specifies how you would like the pre-affected image to
be placed in the new image -- in this case it would be aligned in the
middle. If the height and width were decreased, the image would be
cropped on each side.
·

Crop Image: this shrinks the current image, cropping it to the bounds of
whatever selection you currently have.

Select Menu

·
·
·
·
·
·

Deselect: defloats and removes the selection.
Select All: selects the entire layer.
Select Inverse: inverts the current selection so that areas of the image
that were selected are no longer selected and vice versa.
Defloat: if a selection contains colors that were picked up during a Move
operation, the colors are merged with the underlying layer.
Feather: this blurs the selection and creates a softer edge to the selection
area. Colors data is not modified.
Toggle Outlines: the "marching ants" that appear as the boundary to your
current selection will be hidden or shown by selecting this menu option.

Filter Menu

·

Filters: this menu contains filters that may be applied to a layer or
selection. They are discussed in further detail in the Filters chapter.

Opening/Saving
Pocket Artist can open images in PSD, BMP, GIF, JPEG, and 2BP formats. Work
can be saved in PSD, BMP, or JPEG formats. BMP and JPEG files do not
support layers, so documents must be merged before saving in these formats.

When you start a new document, this is the window that is shown. You may
adjust height, width, and background color for the document. The preset

selection allows you to quickly select some typical document sizes.

Save or Save As may prompt for a filename by using the window shown. The
desired name of the document is entered in the top line. You may specify a file
type by using the drop-down box on the third line. Only the PSD file type will
appear in this box if the document has multiple layers. On the Handheld PC this
window will look different.

Painting Tools

Again, the main interface for Pocket Artist is shown to the right.
The Pocket Artist tool popup menus are as follows:

When any tool is selected, the Tool Options toolbar shows status and options for
that particular tool. The toolbar appears above the main toolbar at the bottom of
the screen. If it is not visible, you may show it by using the View menu.
Below is a description of Drawing, Image, and Text/Shape tools. Selection tools
are explained in the Selections chapter.

Drawing Tools

Paintbrush: this is the standard paintbrush. By clicking and dragging in the
document window, you paint with the foreground color using the current brush.
You can also hold down Shift (HPC) or Action (PPC) and click and it will draw a
line from the last point of which you drew. The Sketch checkbox causes the
brush effect to get darker and darker as you go over the same area. A blending
mode may be selected to cause the brush strokes to combine into the layer in a
non-standard way. The opacity slider will affect how much ink is combined with
the layer.
In the example above, the top stroke is Paintbrush at 20% opacity in normal
mode. As you sketch over the same area, it doesn't get any darker than 20%. In
Sketch Mode (the second stroke), it gets darker and darker, giving the
appearance of a pencil sketch. In the third example, the Blending Mode has been
set to "Multiply" (which in effect darkens the image), and the Sketch Mode keeps
darkening as one goes over the same area. The bottom row of strokes are
examples of varying opacity in Normal Mode (the first five strokes) and Sketch
Mode (the last six strokes).

Pencil: The pencil works very much like the paintbrush tool, but it treats the
selected brush as if it had hard edges. There is no softening effect around the
perimeter of a pencil stroke.

Airbrush: The airbrush also works like the paintbrush tool. It creates a paint
spray effect by varying the opacity of the brush during the brush stroke. Select
Splatter to vary the spacing of the brush stroke as well, creating a more random
effect. Pressure adjusts the opacity range, and therefore how dark or light the
entire effect is. The Blending Mode may be adjusted and works the same as for
the paintbrush tool.

Clone Stamp: takes one area of your image and paints it into another area. By
holding down Action (PPC) or Shift (HPC) and tapping, you set the "source
point." Then, let go of the key and all strokes after that act as a stamp coming
from the source point. If Aligned is set the first brush stroke after setting the
source point defines the "target point", and each brush stroke after that reveals a
reflection of a different part of the picture. If Aligned is not set, the tap at the
beginning of each brush stroke defines another target point. The Blending Mode
and Opacity will affect the paint in the usual manner.
In the example above, the source was set on the cusp of the petal to the left of
the main flower. The area in the top right shows the result of using an Aligned
brush. The area in the bottom left was created without Aligned checked.

Pattern Stamp: paints with an external picture as its source. Click the "Tex"
button to open the Texture window (shown at right). A list of images found in the
"Textures\" subdirectory of the Pocket Artist install directory will be shown here.
Selecting one will show a preview of the image. Tap OK to accept the image and
close the window. Brush strokes on the image will now paint using the selected
image.
Use as Bump Map causes the selected image to act as a rough surface on which
the foreground and background colors are combined. For example, you may use
the canvas texture with any light and dark foreground and background colors to
create a textured surface.
With Align unchecked, the texture is placed relative to the beginning of each
brush stroke. The Align option places the texture consistently across the entire
canvas and is often used when drawing a background texture. The Blending
Mode and Opacity affect the way the texture is drawn on the canvas in the usual
manner.

Gradient: fills the selected area or current layer with continuous blends between
colors. Select a gradient file using the arrow button at the far left of the options
bar. Each gradient file contains one or more gradients. Select a particular
gradient using the listbox to the right of the arrow. Each gradient defines a
transition between several colors and levels of transparency along a line.
A gradient can fill an area using several methods. Tap the gradient button in the
center of the tool options to select Linear, Radial, Sweep, Bar, or Diamond
methods. You may also select Reverse and Opaque options using the same
button. The Reverse option reverses the order and position of colors along the
gradient line. The Opaque option forces the entire gradient to be drawn without
any transparency, ignoring the transparency cues defined in the gradient. This
option is independent of the Opacity option. The Blending Mode and Opacity
options affect the entire gradient as it is painted over the underlying layer.

After selecting appropriate options, tap and drag in the canvas area to create a
Definition Line and draw a gradient. The Definition Line is used to line up the
gradient and draw it in the appropriate place. The interpretation of the Definition
Line depends on the fill type.

Each gradient fill type is illustrated in the picture to the right. The gradient used to
generate the picture blends from blue to red and then to yellow. The Linear fill
was generated using a Definition Line drawn from the lower left of the rectangle
to the upper right. All other fills were generated using a Definition Line drawn
from the center of the rectangle to the upper right.
Pocket Artist comes with a large collection of gradient files, each of which
contains several individual gradients. All gradients are stored in a .GRD file, in a
format that conforms with Adobe Photoshop. The arrow button at the left of the
gradient options bar shows a list of all .GRD files in the \Gradients subdirectory of
the Pocket Artist directory. The full path will usually be "(My Pocket PC)\Program
Files\Conduits\Pocket Artist\Gradients". Additional .GRD files may be created on
a desktop PC using Adobe Photoshop. After placing them in the Gradients
directory on the device, they will be available for use from Pocket Artist.

Paintbucket: fills a region of the picture with the current foreground color. Tap on
the canvas somewhere in the region you wish to fill. All pixels that are connected
to each other and have a similar color are filled. The AA option enables
Antialiasing and softens the edge of the fill. The “Tol.” option changes the
tolerance of pixel color differences before the edge of the region is determined.
The Blending Mode and Opacity levels affect the foreground paint just as they do
for a paintbrush stroke.

Image Tools

Eyedropper: the eyedropper sets the foreground color to a sample color from
the image. Tap the canvas at any point to sample that color. The sampling
technique may obtain the color from a single pixel or from a 3x3 or 5x5
surrounding box. Colors from a box may be evenly weighted (Average) or the
central pixels may be given more weight (Weighted). The Merge option causes
the eyedropper to sample from the visible merged image. If unchecked, the
eyedropper samples only from the selected layer.

Eraser: Eraser works in reverse from the paintbrush. On the base layer of a
document it draws with the background color, and on any other layer it erases
the colors it runs over.

Dodge/Burn: The dodge/burn tool works as a paintbrush that lightens or darkens
parts of an image. Select Dodge to lighten and Burn to darken. Select Shadows,
Midtones, or Highlights to affect that color range. The exposure level is similar to
an opacity level for a brush.

Above, the first column of strokes is Dodge, the second is Burn. The top row is
affecting Highlights, the second is affecting Midtones, and the third is affecting
Shadows. Note how the Highlight Dodge affected the pink flower much more
than the Midtone Dodge, and how the Shadow Dodge affected the dark area
much more than the Highlight Dodge.

Blur/Sharp: blurs or sharpens the image in the area of a brush stroke. The tool
works similarly to the paintbrush. The Pressure determines how much blurring or
sharpening to perform with each stroke.

Smudge: the smudge tool is like taking a wet finger to your painting. Repeated
strokes over an area will blur and smudge that area more. The Paint option
allows you to drop one paintbrush full of paint onto the canvas before each
smudge stroke. The Pressure level determines how much paint is dragged and
pushed around the canvas. Levels of about 50% are the most effective. The paint
that is affected by smudge may be modified through a Blending Mode for
interesting effects.

Red-eye Brush: eliminates red-eye from an image, while retaining lightness and
darkness specular highlights. The tool will draw over selected parts of the image,
replacing it with the foreground color. The "Replace mode" controls what to
replace, either Red-toned pixels, the pixels that match the current background
color, or whatever color you first tap on with the tool (the "Pick-up Color" mode).

Cleaning Brush: removes grain and specks from an image, with adjustable
pressure and radius (noise level).

Text/Shape Tools

Draw Text/Text Outline: These tools enter text into Pocket Artist. Draw Text will
make a new floating selection on your document with the text entered in the
current foreground color, while Text Outline will simply make a selection based
on the text you enter. Options include font name, size, bold, italic, and whether
the font should be antialiased. There is an experimental "angle" feature where
the text can appear at an angle.
By simply tapping (when the Text tool is selected) in the document the "Enter
Text" dialog will open and prompt for the text. Tapping OK will float the text (or
outline) on the document. By tapping and dragging a rectangle on the document,
the same thing will happen, except it bypasses Pocket Artist's auto-calculate of
the text rectangle. This is useful if you would like to chop off the text, or when
working with text at an angle (Pocket Artist does not compute the needed

rectangle appropriately).

To the right is a sample of what you can do with the Text tool. The first line is
simply "Pocket Artist" in bold italic Tahoma. The second line is the same, except
with antialiasing turned on. The third was two instances of the text tool. The first
was set to gray and blurred after placement, and then black text on top, creating
a drop shadow effect. The last example shows text on a layer with the different
blending mode, while the layer below it contains grey smudges.

Draw Line: tap and drag to draw a line between two points. The Smooth option
determines whether the edges of the line are smooth. You may select a line
width from 1 to 10 pixels. Blending mode and Opacity operate as normal.

Rectangle: tap and drag to create a rectangle on the document. Hold down Shift
(HPC) or Action (PPC) to make the rectangle a square. If the checkbox is
unchecked, the rectangle will be filled with the foreground. Check the box, and
select an outline width (1 pixel to 10 pixels) to create an outlined rectangle
instead. Opacity and Blending Mode operate as normal.

Ellipse: the ellipse tool works similarly to the Rectangle tool. Hold shift or Action
to make a circle. The AA option enables Antialiasing and softens the edge of the
ellipse.

Polygon: this tool can draw any polygon. Tap at each vertex of the desired

polygon, moving clockwise or counterclockwise. Tap at or very near the first point
and the polygon will be drawn. The options are identical to the ellipse tool.

An example of the different shapes and their settings is shown to the right.

Photography/Level Tools
Pocket Artist features four interactive ways to adjust the colors of the image (or
selection) as a whole:

· Color Curves: a window will allow you to adjust color levels of the layer or
selection. All colors may be affected or just red, green, or blue components. The

adjustment is represented by a graph with input values along the X-axis, and
output values along the Y-axis. The curve starts out with a rising diagonal line.
This indicates no change. Adjust the curve by drawing on the graph. The
example shown above causes shadow and midrange colors to be darkened. All
changes are shown in the document window immediately.

· Brightness / Contrast: a window will allow you to adjust the brightness and
contrast of the image as a whole. Increasing contrast shifts color values to the full
dark and full light extremes, while decreasing contrast shifts the color values to
mid-way (grey). Increasing or decreasing the brightness absolutely shifts all
colors up or down in their intensity level.

· Hue / Saturation: a window will allow you to adjust color balance of the layer or
selection. By adjusting the hue, you tint the image in the visible spectrum of
color. Adjusting the saturation will either increase the color balance to a "pure"
hue, or decrease the color balance to a greyscale shade. Increasing or
decreasing the lightness will adjust the colors from black, to the current intensity,
to white.

· Levels: a window will allow you to adjust intensity levels of the layer or
selection, for all channels and/or each channel individually. The current intensity
levels are shown in the top graph, and the output intensities are shown in the
lower graph.
By dragging the left slider in the top graph, you adjust the new black point of the
image, which effectively darkens the image, by setting all values below it to
black. Dragging the right slider in the top graph, you adjust the new white point of
the image, which effectively brightens the image, by setting all values above it to
white. Dragging the middle slider in the top graph will adjust the grey level of the
image, which will adjust all the midrange values in a smooth form (akin to
adjusting the gamma of the image).
By dragging the sliders on the lower graph, you adjust the output black and white
values of the output. By dragging these away from the preset black/white areas,
you bind the upper graph's black/white adjustments to the new lower graph's
values, which lead to further improvements in level adjustment.
Other Level Adjustments
The Auto Levels and Auto Contrast tools work by attempting to preset these
level adjustment variables to values that will smooth out the intensity of the

image to fit a "normal" distribution -- that is, not too light, and not too dark.
The Fill Shadows and Fix Overflash tools work with similar algorithms, though
their intent is either to "pull up" dark areas of the image, or "pull down" light areas
of the image, in order to obtain more detail in a picture.

Selections

Pocket Artist support full 8-bit selection areas. This allows selections to have soft
or hard borders and antialiased edges. Pocket Artist features a rich set of tools
and techniques to make selections.
All drawing tools and most image operations are constrained to the current
selection. If there is a selection active, these operations will only affect the areas
of the image surrounded by the selection. The operations that do not respect the
current selection are image/canvas resizing and layer operations.
Below are descriptions of the selection tools.
Selections

Select Rect: this tool selects a rectangular area of the image. Tap and drag in

the canvas to define the rectangle. Hold down Shift (HPC) or Action (PPC) to
force the rectangle into a square. The tool options bar shows the position, width,
and height of the current selection.
The Combine Mode allows you to select Replace, Add, Subtract, or Intersect
from the options bar. When Replace is selected, tap inside a selection and drag
to move the selection without modifying it. Tap outside the selection to remove
the current selection and create a new one. When Add is selected, draw a
rectangle anywhere on the canvas to add the rectangle to the current selection.
When Subtract is selected, any rectangle you draw will be cut out of the current
selection. When Intersect is selected and a rectangle drawn, both the previous
selection and the new rectangle will be removed. They will be replaced by a
selection that contains only the overlap between them.

Select Ellipse: this tool selects an ellipse. It works similarly to the Select Rect
tool. Hold Shift (HPC) or Action (PPC) to force the ellipse into a circle. Combine
Modes work in the same way as Select Rect. The Smooth option creates a
smooth antialiased border for the selection.

Select Row/Column: these tools select a single vertical or horizontal segment of
pixels. When using Select Row, tap the canvas at the left of the edge of the line
of pixels you would like to select. Drag to the right and release. The vertical
position of your stylus will determine the line of pixels selected. The Select
Column tool works similarly. You may use Combine Modes with both tools in the
same way as Select Rect.

Magic Wand: this tool works similarly to the Paint Bucket tool. Tap in an area of
the picture to select a region of pixels of approximately the same color. The
tolerance option determines how closely pixels must match in color. The Smooth
option will antialias the edges of the selection based on color deviation. Combine
Modes work in the same way as Select Rect.

Lasso: this tool selects any shape that you draw. Tap in the canvas and draw a
shape in the document to select it. The Smooth option helps antialias the border
around curves and diagonal lines. Combine Modes work in the same way as

Select Rect.

Select Polygon: this tool selects a polygon that you draw. Tap in the canvas at
each vertex, proceeding clockwise or counterclockwise. Tap at or near the
starting point to close the polygon and select the area. The Smooth option
antialiases the border of the polygon. Combine Modes work in the same way as
Select Rect.

Move: this tool will move the area of a picture under a selection if a selection is
active or it will move the entire layer. If a selection exists, using this tool will
"float" that selection by cutting the area of the image the selection surrounds and
putting that data in a "floating selection". This floating selection exists
independently of the underlying layer and may continue to be moved around
without destroying data underneath it. It will not be merged with the underlying
layer until it is Defloated or Deselected with the corresponding menu items.
If there is no selection, tap and drag in the canvas area to move the entire layer.
If the layer is a base (background) layer, it will be changed into a non-base layer
first. See the Layers chapter for details.

Deselect: this tool eliminates the current selection. If the selection is floating, the
data is defloated and merged into the image first.

Layers
Layers work like panes of glass stacked on top of each other. Every document
begins with a background (base) layer. The base layer has no transparency, like
a sheet of paper. New layers created on top of it are transparent when they are
created, like glass. Only one layer at a time is Active, and all drawing tools work
on this layer. Layers may be manipulated easily by reordering, duplicating, and
merging them.

Layers above the base may have Blending Mode or Opacity values other than
the default in order to create special effects. They may also be Grouped. If a
layer is Grouped, it is clipped by the first layer below it that is not grouped. This is
illustrated to the right. Each brush stroke was drawn on a different layer. The red
brush on the left is not grouped, and is essentially drawn on its own sheet of
glass. The same red brush was used on the right, but grouped with the layer that
contained the black brush. Grouping forced the red color to be limited to only
those areas of the black brush layer that had been drawn on.

All tools to manipulate layers are contained on the Layer Toolbar and Layer
Window. The Layer Toolbar is shown at the top of the window, and may be
shown or hidden using the View -> Layer Toolbar menu command. The Layer
Window covers the document and can be shown by tapping the button on the
right of the toolbar with arrows pointing up and down.

Layer Toolbar
The Layer Toolbar allows you to select the Active layer by using the first listbox.
This box says "conduits" in the picture above. Tapping this box will show a list of
layers in the document and allow you to select one.
The eye button on the far left indicates layer Visibility for the Active layer. A layer
can be temporarily removed from the final image by turning off Visibility. To the
right of the Active layer is the Blending Mode. To the right of that is the Opacity.
The Blending Mode and Opacity works much like the same controls for the
Paintbrush tool. However, they affect all paint on the layer at once.
The arrow pointing to the right will open a menu of Layer Operations.

Layer Window
The Layer Window shows a detailed view of all layers in a document. This is
helpful to get an overview of the layers and move them around easily. Each layer
is shown on a separate line. Layers higher in the list are drawn on top of layers

lower in the list. The Active layer is shown with a blue background.
Each line shows the Visibility of the layer, a thumbnail view of the data in the
layer, and the full layer name. Gray and white boxes represent transparent areas
of the thumbnail. The thumbnail image will be indented if the layer is Grouped.
Tap any layer to select that layer to be Active. Tap the Visibility button to change
Visibility. Tap-and-hold on a layer to change the Grouped attribute. Tap and drag
a layer up or down in the list to change its position and therefore when it is drawn

Layer Operations menu
This menu is accessed from the arrow button at the far right of the Layer Toolbar.

New Layer: simply creates a new layer on top of the Active layer.
Delete Layer: deletes the Active layer and any data contained in it.
Duplicate Layer: creates a new layer on top of the Active layer and copies all
data in the active layer to it.
Layer Options: opens a window allowing you to modify the Name of the Active
layer and change whether it is Visible or Grouped.
Merge Down: paints the Active layer onto the layer below it, merging them
permanently using the current Blending Mode and Opacity.
Merge Visible: merges all layers that are Visible without losing data in layers that
are current not Visible.
Flatten Image: merges all layers that are Visible and discards data from layers
that are not Visible. This command may be used to force an image into one layer
so that it may be saved as a .BMP or .JPG file.

Select Layer: opens a submenu allowing you to Set the selection to the
boundaries of the Active layer. You may also Add, Subtract, or Intersect these
boundaries with the current selection.

Filters

Pocket Artist is packaged with several image-processing filters. Most are selfexplanatory. Shown to the right is an example of some included. There are six
examples; going clockwise, starting in the upper left. They are: find edges,
emboss, sharpen, motion blur, desaturate, and gaussian blur. In future versions,
a public API will be provided that will allow for filters to be developed by third
parties.

Convolve: the Convolve tool is more complicated than other filters. This tool
performs a manual convolution of the image, allowing the user full control over

the process.
A square matrix with odd dimension (in this case, 5x5) is centered above each
source pixel. The color of the source pixel and pixels around it are multiplied by
the corresponding matrix entry. The sum of these colors is divided by the sum of
all matrix entries, and a shift value is added to create the resulting color.
Interesting preset matrices are included, but a full discussion of the possibilities
cannot be included here.

Blenders

Several parts of this documentation refer to Blenders, Color Blenders, or
Blending Mode. They are all discussed here. A list of blenders that Pocket Artist
supports is in the image to the right. Blenders are a way of mixing two colors to
provide a new one. They can be simple (such as the Normal blender, in which
the color on top replaces the color on the bottom), to complex (such as the
Overlay blender, which involves several factors, overall giving the appearance of
a colored transparency overlay. Below are descriptions of the blenders. In the
descriptions, two picture layers are assumed. The blenders that the painting tools
utilize can be pictured as having a layer of a solid color (the foreground color) on
top of the picture you are painting on.
Normal: the top color replaces the bottom, just as if you painted over the bottom
layer with opaque paint.
Multiply: each color component of the top layer is multiplied by the bottom color.
White will have no affect. Any other color will darken the bottom color.

Screen: almost the inverse of Multiply. Black will have no effect. Other colors will
lighten the bottom color.
Overlay: this is a complicated blender that combines both Multiply and Screen to
form a blending mode that acts as if the top layer is like a color transparency that
overlays the bottom layer.
Soft Light: the top layer lightens or darkens the image slightly depending on the
brightness of the top layer. This effect takes place for each color component. It
emulates a soft light or shadow of the appropriate color on the base layer.
Hard Light: the top layer lightens or darkens the image harshly depending on the
brightness of the top layer. This effect takes place for each color component. It
emulates a much harder light than Soft Light.
Color Dodge: this blender uses the top layer's colors to brighten the bottom
layer's colors.
Color Burn: this blender uses the top layer's colors to darken the bottom layer's
colors.
Darken: this simple blender yields a color that is the minimum of the two colors.
Lighten: the opposite of Darken, this blender yields the maximum of the top and
bottom colors.
Difference: this blender yields the absolute value of the difference between the
top and bottom layers. Large color differences are brighter. Similar colors yield a
dark result.
Exclusion: this blender is somewhat like Difference, but when the top and
bottom colors approach the same value, the result is gray instead of black.
Hue: this blender combines the hue of the top color with the saturation and
luminosity of the bottom color. Hue indicates the base color - red, yellow, cyan,
etc. Saturation defines how rich or washed out the color is. Luminosity indicates
brightness.
Color: this blender combines the hue and saturation of the top color with the
luminosity of the bottom layer.
Saturation: this blender combines the saturation of the top layer with the hue
and luminosity of the bottom layer.
Luminosity: this blender combines the luminosity of the top layer with the hue
and saturation of the bottom layer.

Glow: this blender combines the color intensity of the top layer into the bottom
layer with a 'glowing' effect akin to a neon light.

Effects
In this space Pocket Artist enthusiasts will contribute to documentation on how to
create interesting effects -- tutorials and how-to's on mastering all the features of
Pocket Artist for a richer creative experience.
If you are interested in contributing, please email artist@conduits.com.

Other Features
Pocket Artist has some other interesting features that are specific to Windows
CE.
Capture Screen

Pocket Artist can capture the screen display and copy it to the Pocket Artist
clipboard for pasting into your document. Picking "Capture Screen" on the tools
menu will prompt for a time delay, at which point you may set up for the capture.
Your Windows CE device will beep when it is capturing your screen.
Pocket Artist can set the current picture to the desktop by picking "Use As
Desktop" from the File menu. Desktop images can only be saved in BMP format
(a limitation of CE). Pocket Artist will prompt if you would like the image to be
tiled, and whether to switch to the desktop temporarily to view the image.
User Preferences

User Preferences are divided into general options, stylus options, and file
associations. The default for all options is checked and should normally be used.
On the general options tab you will find the following items:
·
·
·
·

Antialias paintbrush strokes: draws the paintbrush on a subpixel level to
create a smooth looking stroke. Disable to speed up paintbrush operations
at the cost of visual quality.
Utilize brush spacing information: honor minimum spacing for each
'stamp' of a brush while drawing. This is used to create special effects with
some brushes. Disable to always create a smooth stroke.
Use Cleartype on menus and windows: use subpixel font rendering for
tool menus and windows. This does not affect the main menu. Disable if
you would prefer to have higher contrast text borders at lower resolution.
Perform Zoom-to-Fit upon Load/New: whenever opening a document,
zoom in or out to fit the document within the canvas area. Disable to
always load documents at 100% zoom.

·
·

Remember tool settings / Reset: whether to save the settings of the
different tools, such as opacity, sketching mode, and tolerances.
Use rigid memory protection on loading: Pocket Artist does its best to
predict when there might be memory problems during an editing session.
As a result, it may report that it cannot load certain images into memory,
when in fact it might indeed be able to, given that there aren't going to be
major edits done to the image (such as full-canvas gradients, new layers,
etc). Disabling this checkbox will bypass the advanced memory warning
prediction, but might have side effects while editing.

On the stylus options tab you will find the following items:
·
·

·

Use additional stylus movement data: use the device hardware to
correctly interpolate the full path of fast stylus movements. Disable if rapid
stylus movement creates inaccurate results on your device.
Reduce stylus jitter: average a number of points during drawing tool
movement to smooth the behavior of the tool. This helps counteract the
tendency of stylus input devices to produce random variations in signals.
You may select the Number of Points to be averaged. This determines
how much smoothing is performed. Disable or reduce Number of Points if
rapid stylus movement produces inaccurate results.
Snap to stylus release point: only takes effect if Reduce stylus jitter is
selected. This option forces the release point to be unaveraged. It is
recommended. Turn the option off if you plan to always hold the stylus at
the release point for half a second.

On the Associations tab you can choose whether Pocket Artist is associated with
PSD, JPEG, GIF, BMP, PNG, and 2BP files.

Tips
This section of the documentation provides some tips and advanced usage for
Pocket Artist, and will expand as people contribute. If you would like to submit a
tip, mail artist@conduits.com.
Handheld PC Keyboard Shortcuts:
·
·
·
·
·

B Brush
C Copy Tool
E Eraser
G Smudge
H Toggle Selection Outlines

·
·
·
·
·
·
·
·
·
·
·
·
·
·

I Eye Dropper
J Air Brush
K Paint Bucket
L Lasso
M Square Selection tool
N Pencil
O Dodge Burn
R Blur Sharpen
S Rubber Stamp
T Text
V Move Tool
W Magic Wand
X Swap Foreground/Background Colors
Z Zoom in (Shift+Z Zoom out)

·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·

Ctrl+A Selects All
Ctrl+B Brightnes and Contrast
Ctrl+C Copy
Ctrl+D Deselects
Ctrl+Shift+D Feather Selection Menu
Ctrl+F Fill Menu
Ctrl+I Inverts Colors
Ctrl+Shift+I Inverts Selection
Ctrl+M Curves
Ctrl+N New Document
Ctrl+O Opens file
Ctrl+S Saves current file
Ctrl+V Paste
Ctrl+X Cut
Ctrl+Z Undo
Ctrl+Shift+Z Zoom to 100%
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